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Copyright © 2007 Promethean Limited. All rights reserved.

If this guide is distributed with Activstudio software, it may only be reproduced for use within the
institution to which the software is licensed. For use outside of your institution, no part of this
guide may be reproduced, transmitted, stored in a retrieval system or translated into any other
language without the prior permission of Promethean Limited. Please note that the content in
this guide is protected under copyright law, even if it is not distributed with software that includes
an end user licence agreement.

Please remember that existing artwork or images that you may want to include in your
Activprimary projects may be protected under copyright law. The unauthorized incorporation of
such material into your flipcharts could be a violation of the rights of the copyright owner; please

be sure to obtain any permissions required.

Although every care has been taken in the compilation of this training manual, Promethean
Limited accepts no responsibility for errors or omissions, or for damages resulting from the use
of information contained within the following pages.
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Welcome to Activstudio 3
We've been listening to what teachers want and have distilled that
feedback into the latest version of Activstudio. In this booklet we will
introduce you to some of the most important new features of the
software.

In brief

We’'ve enhanced the software, so Activstudio is even better for
teaching at an interactive whiteboard.

We've made designing lessons simpler, whilst significantly
increasing the opportunties for creativity.

We've improved the training we offer you.

...all working together to help improve your students’ learning.

© 2007 Promethean Ltd Activstudio 3 New Features 1



THE DASHBOARD:
THE LAUNCHPAD FOR YOUR TEACHING

Activstudio 3 comes equipped with a whole new launchpad for your

teaching: the dashboard. The dashboard helps you to organise your
teaching and offers the starting point where you can really learn how
to make the most of Activstudio and your interactive whiteboard.

enNnn Welcome To ACTIVstudio 3 by Promethean

ACTIVstudio

{New!Operl | Configure Online Training Suppaort !

Create: Open from:

—_—

|| New Flipchart I'-_"-.- Shared Flipcharts
——— e

£ Custom Flipchart "-_"-.- My Flipcharts
;; Flipchart Builder E . Shared Assessments

) =

‘?i' Assessment [ Quiz r?‘ My Assessments

ilixi . e
Tools & Utilities: %] | Other Location
g ACTIVresource Manager
¥  Activity
Open a recent flipchart:
7 camera_viewer.flp T wtd.flp
T tut?.fip T wits.fip
EShow this window each time the Application runs. tf Close \]
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The Dashboard

Some of the dashboard’s most important sections:

Training

Visit this page to find the training method of your choice.

Choose from:

o Manuals
° Face-to-face training
eNnn Welcome Te ACTIVstudio 3 by Promethean
ACTIVstudio
" New/Open Configure  Online | Training | Support ]
M
BE A SUPER TEACHER \
-
LIGHTING THE FLAME OF LEARNING
Online Training & Training Manuals Face to Face Training
Accreditation
: o . The following training manuals are At Promethean, we provide face to
gnrlglczggg ng;;":urgdfa:mm;::a d available to_c_lown load. These are face training solutions to suit your
; PDFs reguiring needs.
now available at Adobe Acrobat Read
prometheanlearning.com obe Acrobat Reader
nd_! FREE ] ] Onsite training
="A‘ Activstudio o Activstudio 1 sesslons
- Professional '/ Version 3 New Training can be
User course . Features delivered at
Siqn up now This manual is an your school or
Feénurgs fulry. oVEryiew ofth_.e institution.
interactive mfsetau?;ﬂ in
tutorials and ) " "
tracked - Onsite courses
assessments. P available
Intredueing ‘We offer
H Activstudio specific courses
i This manual for primary &
F x‘::z:"r:: shows you how to secondary
Developer get started with education. We
oounasp your Activstudio can also provide
: software. acourse -
Egm;:g'ggime tailored to your A
own needs. i

I_WB expert

gShow this window each time the Application runs.
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The Dashboard

Promethean Planet
Register for free on Promethean Planet to join the Promethean
community and share resources, flipcharts and ideas with other

teachers.

eoo

Welcome To ACTIVstudio 3 by Promethean

ACTIVstudio

[

New/Open Configure | Online | Training Support = |

PROMETHEAN PLANET

If you use an interactive whitebcard or electronic voting system, Promethean Planet is for you.
It's @ FREE, online community designed with one goal - supporting teachers. Learn more >

USEFUL LINKS

FEATURED RESOQURCES

Top Teaching Tips

‘We asked Planet members to share
their Top Teaching Tips' for
Activboard success. We've collated
the tips, now read the results!

International flipcharts

The International Flipcharts section
is growing, so why not have a look
at what you can use? Work
submitted includes flipcharts from
Sweden, Croatia and Brunei.

Latest Activstudio resources
Why not the visit the Rescurce pack
area to see what's new? Latest
Activstudio resource packs include
pictures of Africa for geography
lessons.

Could you be the next Featured
Teacher?

‘We're looking for a secondary
teacher for our Featured Teacher
section that can inspire our global
members with their excellent
teaching!

Activote Algebra

A maths flipchart with 16 mixed Algebra
questions set up for use with Activote.
Ideal for an 11 — 16 year old class age
range.

Continental Challenge

In this activity, students have to label a
map of the world with the continents and
a map of Western Europe with the
relevant countries.

Gas Laws

This flipchart covers core concepts of
Gas Laws for High School Chemistry
and includes sound, video and Activote
questions.

> Projecto Interact - um caso de sucesso em
Partugal

> Browse over 1,400 flipcharts

> Exchange ideas with other global members
> Suggest a new feature

> Report a technical issue

E.‘Show this window each time the Application runs.
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The Dashboard

Support
Check here for software updates.

enn Welcome Te ACTIVstudio 3 by Promethean
ACTIVstudio
" New/Open Configure Online = Training | Support '!—————
Application Details: Hardware Details:
ACTIVstudio PE 3 Build 78 Mo clevine Heteeted
Check for Update
[C ) C Open ACTIVboard Hardware )
Status
Press button to check for updates. C Support Web Site )
Support Tools:
5]
‘ | Get System details
gShow this window each time the Application runs. {—Close—)
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LESSON CREATION IS QUICKER

Teachers have asked us to create templates to help with lesson

design. These templates are now instantly available by clicking on
Flipchart Builder in the dashboard.

Flipchart builder and flipchart templates

More flipchart templates will be available to download from
www.prometheanplanet.com.

8eoe

Flipchart Builder - untitled

PR=0_ -

Save and Open in ACTIVstudio

EET

1is®

v | ACTIvstudio3
» [ Shared Assessments
[‘j Shared Flipchart Pages
v [‘j Shared Flipcharts

e L
. Templales.ﬁp Page 01.ap2 Page 02.ap2 Page 03.ap2
o - = P —
O
i Page 04.ap2 Page 05.ap2 Page 06.ap2
o
Page 07.ap2 Page 0B.ap2 Page 09.ap2
Name: Page 05.ap2
G - Size: 37.65 KB
|
I I : s Kind: ACTIVstudio Flipchart
% Yalrl . M - v Created: 11/06/2007

Pages: 1of 17

File Size: 37.65 KB

Activstudio 3 New Features

© 2007 Promethean Ltd



DESIGNING FLIPCHARTS IS SIMPLER

We have created Design Mode and Presentation Mode. Use Design
Mode to create flipcharts. Use Presentation Mode’s teaching layout
when working at an interactive whiteboard, keeping the most
important tools within easy reach.

Design Mode and Presentation Mode

Design mode |\,
Flipchart

ACTIVslate
ACTIVote

ACTIVextras

Customize

Preferences...

Dashboard

Lelp Design Mode
Quit

Presentation mode
Flipchart

ACTIVslate
ACTIVote

ACTIVextras

vy v vy

Customize
Preferences... 8,

Dashboard
Help >

Quit

Presentation Mode

© 2007 Promethean Ltd Activstudio 3 New Features 7



IMPORT AND EXPO

RT RESOURCES

Tools & Utilities:

I- ACTIVresource Manager

Visit the Activresource Manager for
options which let you import and
export resources.

Download themed Pack and Go
resources from Promethean Planet.

Pack a set of resources you
easily with colleagues.

have created so they can be shared

806

amE) [ § abe
v | ACTIVstudio3
|7 Shared ACTIVities
|7 shared Annotations
|7 shared Assessments
|7 shared Backgrounds
v [ shared Collections
v [ Basic resources
» [ Annotations
» | Backgrounds
|7 Flipcharts
» [ Grids
» [ Lines
> [4 Shapes
|7 sounds
v [ History
v [ Tudors
[ 7 Buildings
[ characters
[4 Country
Figures
Furniture
Kitchen
Maps
Music
Portraits
Punishment

\b

»

A
4
A
A
4
A
i

[T

___ Ralininn

e |

Files: 15

Jalw!

"|  JaneSeymour. 2152

=

i

ol u et

defender.as2 Drake.as2

Edward.as2

Elizabeth.as2 Henry Vil.as2 Henry VIII as2

&

Mary Sct.as2 Mary Tudor.as2 Philip.; ESZ

B
=

Raleigh.as2 Shakespeare.as2 Wolsey.as2
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FOCUS ON TEACHING

Exclusive to Activstudio and Activprimary software: now you just
have to wave your Activpen to make what you want happen.

Gesture technology

You can turn the page, switch on your favourite tool or even save
your document without having to click on any icons. In this way you
can manipulate the software so that it does exactly what you want.

ACTIVstudio Preferences

ACTIVote

Barrel Button
Clock
Dashboard
Design Mode
Effects

Flipchart
Flipchart Cbjects
General

Linked File Hosting
Multiple Monitars
Page Turn Effects
Profile and Resources
Recordings

Search

Shape Recognition
Toolboxes

Toals

User Input

@

Gesture Wheel

" Enable Gesture

E Show Gesture Points

Tolerance:

i ol

Strict Relaxed P ,' . o 2 ,'

Size: - -
Smaller Larger 7 ! N o ! N 3 !

Speed: e

_e—. B LAY

Fast Slow - A

Cesture:

Togale On/Off Pen Tool )—:IE
20 "N/A B
30 [ Undo 4]
40 " NjA i
50 " Go to the Next Page I—:] 4
AN " Nia [ 1A

[ — : JERRS
(Cancel ) € oK )
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INTERACTIVE FLASH RESOURCES

Visit the Shared Activities section of the Resource Library for some
interactive Flash resources to help when working with numbers and
words.

LA
o] w2 1 o
o] o] o2 o2
ol o2 o

CIS==SI=Iil
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COOL NEW FEATURES FOR DEVELOPERS

Advanced users of Activstudio have been clamouring for yet more
features to give them further creativity when creating lessons. The
new options in the Properties and Actions box offer over 200 new
actions and other settings for you to explore!

The Properties and Actions box

# | To find the Properties and Actions box double-click on an item
on your page and select the Properties icon from the Object Edit

[a) Textl Properties and Actions @ () Textl Properties and Actions. @
Identification Container: Identification
Position ! Return if not contained Position Name: |Textl
Appearance - B
£e _ Reward Sound Appearance
i Keywords:
Restrictory = Container
Actions Restrictors
Can contain: | Nothing @ Actions
Contain Rule: | Enclose Object & |
Textl Properties and Actions
o B i 0 Textl Properties and Actions @
i i Restrictors:
Idengﬁcutnon ) \dentification Position:
Position Can rotate: | Freely B‘ - — a1
Appearance Prsition Left: 597  Width: 69
Container Rotate Step: Appearance
. — Container Top: 471  Height: 37
Actions Rotate point: [ Defau  [%) Restrictors —
- M
[ Can block @ Can snap Actions - Sl acad
Snap Point: | Text Baseline B‘
Can move: | Freely @
Can size: | Freely 5] 0 Textl Properties and Actions [}
Identification Appearance:
Position Layer: | Middle B
[6) Textl Properties and Actions @ | Appearance (SRS SRRSO
Container
Identification Actions: Restrictors ™ visible ) Reflected
y —— . -
:Zi:::mce @ al O Object Actions [ Show Outline:
O Fil Ia) 5
Container ChAls O Olgect Size outline width: '1 | Color: [l
Restrictors () ACTIVstudio Functions () Object Position -
o o = Gl
O Page O others
color: [
() Prevent the action when object is hidden .
[_! Background color: [
Do Nothing 9‘
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EXTRA TOOLS IN THE TOOL STORE

Previously, some of Activstudio’s most popular icons, such as the
Straight Line tool and the My Images icon, were not available in the
Tool Store. Now you can add these icons, and many others, to any
toolbox of your choice.

Explore the Tool Store.

8 o Tool Store @ 066 @
’l_‘5 Standard Tools 'T—E’ i
g MY /PO TR S OCHASSLEBER Oy
6‘.‘% Presentation Tools Highlighter "Fool = = = . : ....
w QimQOm_ Ao WLIOHS -
% Power Tools HAGH
g ROGREEAL AU uus i a=y M/
Pen Modifier Tools & '
o T A e =g g T %
! Edit Tools = : ;'
DA sE A0 L Fhi@nss s 2@ 8%
% R @ sh - &
a esource ﬂ(Eqi)ly ortcuts — = .i q
o BEERDIDNAJNE A EMZ 6 0OW T B
9 0 Quick Select & @
=7 e er
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INSERTING LINKS IS EASIER

Using multimedia such as Flash files and videos is a fundamental
part of Activstudio. Now, inserting links to a range of file types is
easier. Explore the options here, also, to place the videos and Flash
files directly in the flipcharts.

Edit >
Paste > I
Insert » Flipchart Link...
Add to Library > Web Site Link...
Export Page... Document Link...
Crid Color... Flash File Link...
Show Action Objects Video File Link...
Enable Actions Sound File Link...
Unlock Background Objects Other File Link...
Make Tickertape Flash Placeholder...
Deconstruct Word Video Placeholder...
ACTIVote > Page Before Current
— Page After Current
T

© 2007 Promethean Ltd Activstudio 3 New Features 13



WORKING WITH TEXTS

HAS

BEEN STREAMLINED

Instant typing
Now, to type on the flipchart just click where you want to put the text
and start typing.

Text editing

To edit text in Design mode:

1. Click once on the text to select it.

2. Click on the text again to begin editing.

Text format painter

If you like the look of a text on the page you can now copy the text’s
formating to other texts.

To do this:

1. Select the Colour Picker tool.

2. Press Alt on your keyboard and, at the same time, click on the
text to copy its formatting.

3. Select the Fill tool.

4. Press Alt on your keyboard and, at the same time, click on any
text you want to change to the copied style.

Instant colour change
Select a text and now you can change its colour using the Main
toolbox’s colour pallete.

Reflect your texts @ o
Right-click options ﬁé‘"‘ _O ,
now let you reflect g Edic | Cu
= Paste > Copy
your texts. Insert > Duplicate
Add to Library » Delete
Export Page... .
Show Action Objects A L=,
Enable Actions - n
Flip »> In'Y Axis
Make Tickertape [—
Deconstruct Word L°C]k
uniock
~ ToFront
To Back
Layer »
Align »
—
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MORE OPTIONS
WHEN WORKING WITH IMAGES

Pick-up boxes

We’ve moved two of the software’s pick-up
boxes so that they are easier to select on an
interactive whiteboard. A small but important
demonstration of how we respond to teachers’

feedback.
Also the Hand Mover pick-up box has been a @ o
added to make it easier for dragging objects to | ?ACTIVSTUDIO =

the Flipchart Bin or into the Resource Library.
You can change the size of the pick-up

boxes in the Flipchart Objects section of the
Activstudio Settings box.

=] N

L] - | ]
- |ACTIVSTUDIO | 1

Pick-up boxes are now also available on Flash objects.

Instant grouping

We've created an icon to make
grouping easier. Select two or more
objects and the grouping icon will
appear with the other pick-up boxes.
Click on this icon and your items
will be grouped. Click on it again to
ungroup your icons.

© 2007 Promethean Ltd Activstudio 3 New Features 15



More options when working with images

Aligning images

Creating neat pages is easier with the help
of these new right-click options. Using these
menus, you can select a number of objects
and line them up instantly.

E Paste »

ﬁ Insert >

Add to Library »

Export Page...

Show Action Objects
v Enable Actions

Make Tickertape
Deconstruct Word

—

Cut

Copy
Duplicate
Delete

Fit

Mirror
Flip

Lock
Unlock
To Front
To Back
Layer

v

Center X

Right

Top

Center Y

Bottom

Width

Height

Angle

Complete
T—
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REFINED TOOLS

Flipchart Bin
Just click on an item then click on the Flipchart
Bin to delete the item from the page.

Camera tool

Now you can perform keyboard nudges when
using the Camera tool. Click on the arrows on
your keyboard to help you define the area you
want to snapshot.

© 2007 Promethean Ltd Activstudio 3 New Features
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NEW ICONS

You can find many new icons in the Tool Store so you can add them
to any toolbox of your choice. Here are a just a few of them:

Q_J Page Notes

H:l Arrange Windows

Q Enable Actions

-] Enable Gestures

Object Edit toolbox — new icons | e ~
A transparency slider has been *ARWEIEr-URB =
added to the Object Edit toolbox, letting you make your images more
or less translucent. Two new buttons let you arrange your images,
sending them to the back or front of a group of images. Double-click
on any item on your page to open the Object Edit toolbox.

Fraction Creator tools
Options are now available so your fractions can be made up of
numbers and/or letters.

0 Fraction Creatar Tal Fraction Creatar Tal Fraction Creatar
Ty
rs “l \ S~
A L)
E A
2D \
/ ™ [N =N
rd i
-4 [ ,, I
X 2x 2 2% 2 X
Y ¥ 3 3y 3y
€ Cear ) —add—) ( Clear ) ( add ) ( Cear ) ( add )
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PROFILES

If you want to see more tools — or less tools! - as you teach, try
experimenting with the profiles in the dashboard. Start with the
basic profile and as you become more confident with the software,
change your profile here. You can also create your own profiles, so
the tools you see are tailored to your lessons. These profiles can be
saved to use again, or shared with colleagues.

800 Welcome To ACTIVstudio 3 by Promethean

ACTIVstudio

" New/Open | Configure | Online = Training = Support )

Setup ACTIVboard: Customise Application:

h ACTIVboard Preferences

;

‘% ‘ Toolbox Store

—

|
|

Calibrate ACTIVboard General Program Settings

Fl
—

Setup ACTIVote: Load/Save Profile:
( Save My Profile as...

@

Register Devices
( Load Profile...

|

Select from installed Profiles

Allocate vote devices

%

I+ CApply )

|

¥

Open ACTIVote User Database

|

Assessment [ Quiz

[

Setup ACTIVslate: Virtual Voting:

O

Register Devices ‘ @ ‘ Start [Service is Off]

[ —

EShow this window each time the Application runs.
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OTHER NEW FEATURES

.%7? The Grid Designer

The Grid Designer, available in the Tool Store,
lets you design the exact type of grid you want.

(&) Grid Designer

Grid: ™ visible
] On Top

] Allow Snap

Default Scale: 4 3’ Step Scale: 0.5 E‘
Thumbnail Scale: 1 z Total Levels: 1 z

TP S —
E Visible E Snap
Color: _l [ Move To Front |

X Start: 0 Y Start: 0

[CDN T
| CID N €I

Y Step: 32

Style: | Normal 9‘
Type: | Lines 9‘

X Step: 32

Direction: | X-Y B
@ [ Reser ( cancel ) o)
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Promethean Learning Gt ’é’ﬂ

For more training ideas, visit Promethean’s
training website:
http://www.prometheanlearning.com.

Promethean Planet W o

Promethean Planet is a free, online community
designed with one goal - supporting teachers.

Visit: http://www.prometheanplanet.com

Monday - Friday 08.00 - 17.30 GMT

+44 (0) 870 165 2210
http://uk.prometheankb.com
Promethean House, Lower Philips Road,
Blackburn, Lancashire BB1 5TH UK
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